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Before you begin this chapter,
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take the chapter pretest. If you
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The Pew Internet Project recently studied
mobile technology and released these facts
about American adults: 90 percent have a cell
phone, 58 percent have a smartphone, 32 percent
own an e-book reader, and 42 percent own a
tablet computer. Today’s telephones are small
computers with more computing power than
many desktop computers of just a few years ago.
Messages are shared using smartphones, other
mobile devices, and traditional computers via
e-mail and social media. In addition to sharing
messages, people use online collaboration tools
to videoconference and share files in real time.
This allows projects to be staffed by people
around the world.

With the increased speed of conversations
occurring via e-mail and social media, taking
shortcuts in writing is more common. However,
this can lead to a poor image of the sender.
Additionally, without the inflection and tone
of voice found in face-to-face encounters,
communication can be misinterpreted.

Video connections tend to minimize those
troubles. This chapter explores facets of online
communication and collaboration.

@® Reading Prep. Arrange a study
session to read the chapter aloud with a
College c!assmate. At the end of each section,
and Career discuss any words you do not know.
Readiness Take notes of words you would like to
discuss in class.
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IC3 CERTIFICATION OBJECTIVES

Computing Fundamentals

Domain 1.0 Mobile devices
Objective 1.1 Understand cellular phone concepts
Objective 1.4 Understand the use of hard-wired
phones
Objective 1.5 Use of instant messaging
Objective 1.6 Know how to configure notifications

Domain 2.0 Hardware devices
Objective 2.10 Know the difference between
cellular, Wi-Fi, and wired networks

Domain 5.0 File sharing
Objective 5.1 Understand file transfer options and
characteristics

Domain 6.0 Cloud computing
Objective 6.4 Web apps vs. local apps

Living Online

Domain 3.0 E-mail clients
Objective 3.1 Identify e-mail applications

Domain 4.0 Calendaring
Objective 4.1 Know how to create events and
appointments
Objective 4.2 Know how to share calendars
Objective 4.3 Know how to view multiple calendars
Objective 4.4 Understand how to subscribe to
calendars

Domain 5.0 Social media
Objective 5.1 Understand what a digital identity is
(identity on social media)
Objective 5.2 Recognize the difference of internal
{school/business) vs. open media sites
Objective 5.3 Know what blogs, wikis, and forums
are and how they are used
Objective 5.4 Know what cyberbullying is

Domain 6.0 Communication
Objective 6.1 Know the best tool for the various
situations and scenarios
Objective 6.2 Know how to use SMS texting
Objective 6.3 Know how o use chat platforms
Objective 6.4 Understand options for and how to
use distant/remotefindividual learning technologies

Domain 7.0 Online conferencing
Objective 71 Understand and identify online
conference offerings

Domain 8.0 Streaming
Objective 8.1 Understand what streaming is and
how it works with devices

Domain 9.0 Digital principles/ethics/skills/citizenship
Objective 9.1 Understand the necessity of coping
with change in technology )
Objective 9.3 Understand an online identity
management
Objective 9.4 Know the difference between
personal vs. professional identity

Key Applicaiions
Domain 6.0 Collaboration
Objective 6.1 Commenis
Objective 6.2 Sharing files
Living Online
Domain 3.0 Digital communication
Objective 3.1 E-mail communication
Objective 3.2 Real-time communication
Domain 4.0 Digital citizenship
Objective 4.1 Communication standards
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SECTION

Electronic mail is the process of
trading digital messages from one
person to one or more receivers.
Early e-mail programs required both
sender and receiver to be logged

B, into the e-mail program at the same
What would society
look like without
e-mail?

time. In function, this was more like
text messaging than what today is
thought of as e-mail. Now, e-mail
messages are saved on a server and
downloaded when a user opens the
local e-mail program.

Electronic communication is supported by many
devices and many software programs. Today, electronic
communication is outpacing telephony, which was
once the most popular method for communication
between people at a distance. There are two parts to the
process of sending and receiving e-mail: a client e-mail
program and a server-side e-mail program. This section
explores the technology of e-mail, its applications, and
its features.

ELECTRONIC MAIL

auto-respond option netiquette

contact group out-of-office message

credential post office protocol (POP)
digital citizenship simple mail transfer
e=rtiail clictt protocol (SMTP)
e-mail server SEad

username

Internet message access
protocol (IMAP)

& N R
TERMS 2 | | LEARNING
address book junk e-mail GOALS
archiving message header After completing this

\.

section, you will be able to:

® Discuss various e-mail
technologies.

® Describe typical e-mail
account settings.

¢ Explain appropriate l

e-mail use.

* Manage e-miail -
communication. |

—
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E-mail Technologies

In the early days of the Internet, while using the FTP to send files
between networks, Ray Tomlinson thought it would be nice to send a text 6.1.1
message describing what was being transferred. To do this, he created the
first electronic mail program. Electronic mail, today known as e-mail, is
communication sent to a computer address where the message is stored
to be read at a later time by the recipient.
The e-mail client is the program used to create and send the message.
When the message is sent from an e-mail client program, it ends up on the
e-mail host or server, as shown in Figure 15-1. The e-mail server handles
the storing and delivery of the message. The message is stored there and a
copy is forwarded to the recipient when that user opens his or her e-mail
client. The message is stored on the client device until the user deletes it.
The copy on the server is not deleted.

Living Online

E-mail Message

An e-mail message has three components:
e message body

e message header

® message envelope
The message body contains the text of the message itself. The message
header contains a variety of information necessary to ensure the proper
delivery of the message. Items such as the sender’s e-mail address, the
receiver’s e-mail address, the e-mail subject line, and the date and time
sent are included. The message envelope is the encrypted bundle of the
header and the body that is sent as a unit according to e-mail protocols.
There are several protocols associated with e-mail, including IMAP, POP,

and SMTP.
Message Header
S g --Message.""
Body
7 Message Header
_| Message n
A Body [ Message Header
A T T Message Br—=-- -
Body e
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Figure 15-1. The e-mail server is at the center of sending and receiving e-mail messages.

Copyright Goodheart-Willcox Co., inc.
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IMAP sends copies of
messages to all e-mail
devices used by the
account holder,

~4 Living Cnline

g 3.1.1

IMAP

The Internet message access protocol (IMAP) describes how to
store and retrieve e-mail messages. It is an application-layer protocol that
provides an e-mail client’s access to a mail server. An e-mail box is set
up on the server for each user. Messages are stored in the e-mail box and
delivered to the user either on demand or automatically. One of several
different e-mail clients can be used to interact with the e-mail server. An
e-mail application program such as Microsoft Outlook, web-based mail

service, and smartphone mail programs can be used to access the e-mail
server.

POP

The post office protocol (POP) is also an application-layer protocol
that describes how to store and retrieve e-mail messages. The main
difference between IMAP and POP is that in POP each e-majl client must
independently download the messages from the server. POP predates
IMAP, and both protocols are supported by most e-mail systems.

SMTP

The simple mail transfer protocol (SMTP) is used to transfer mail
from one e-mail system to another over the Internet, It was the first
standard that emerged from the ARPANET. SMTP is how the message

gets to the e-mail server, and then IMAP or POP delivers it to the e-mail
client.

E-mail Account Settings

Access to an e-mail account is restricted. Each user of an e-mail
system must have a unique account username. The general format for an
e-mail address is the username followed by the at sign (@) and the DNS
name of the e-mail server, such as JaneDoe@easymail xyz.

Username

The username is the online identity of the account holder. The
username must be unique for that e-mail provider to ensure the e-mail
address does not conflict with other e-mail functions. Username
requirements vary by e-mail system. These restrictions will be noted as
an account is being created. A common example of a restriction is not
permitting the use of special characters, such as /, @, and %.

If the account will be used only for personal e-mail, a playful
username is acceptable, such as FunnyCat. However, if you plan to
conduct business using the e-mail address, including conducting
job searches, a proper username is better, such as your first and last
names. Many people use variations of their own name for business
e-mail usernames. Underscores, hyphens (dashes), or periods (dots)
can be used to make the e-mail address easy to read and recall, such as
Mateo Vasquez@mail.xyz. /

Copyright Goodheart-Willcox Co., Inc.
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Password

Guidelines for creating a safe password are discussed in Chapter 16.
Different e-mail providers may enforce stricter password rules. All rules
for creating a password will be outlined as the account is created.

Some e-mail clients offer to remember your password. From a
security standpoint, do not allow this. The password is meant to protect
you and your messages. The time it takes to enter a password is far
less than the amount of time it would take to repair damage done by
unauthorized access. If you are the only user of the computer and a
password is required to start the computer, you may consider allowing
the e-mail client to save your password, but it is still better not to do so.

Techhology

The technology used for
mass communication

has evolved drastically.
One of the earliest known
forms dates to 3000 BC,
when the Egyptians
perfected hieroglyphics.
Just in the last 400 years,
humans have gone from
the first newspaper to

the telegraph to video
conferencing in real time
on smartphones.

Credentials

In terms of information technology, a credential is a record that saves
the authentication criteria required to connect to a service, such as e-mail
or other database-supported resource. A credential can be as simple as a

username and password. It may additionally contain security questions,
require a phone number, or require a valid e-mail address. A credential

is most often used to verify a user’s identity. In the case of retrieving a
forgotten password, the user may be required to provide information in
the credential to verify he or she is the actual user, not somebody trying to
hack into the system.

Microsoft Outlook

Microsoft Outlook is an e-mail client in the Microsoft Office suite.

The user interface is shown in Figure 15-2. Take some time to learn the
interface and investigate the features supported. Notice the common
elements used by all Microsoft Office applications.

QOutlook is not an e-mail service, it is an e-mail client. That is, Outlook
can combine all of the e-mail accounts you have with e-mail providers, but
it does not allow you to create a new e-mail service. For example, Outlook
supports adding an existing Gmail account. To add an account to Outlook,
use the Add Account command found on the File tab of the ribbon. A
wizard guides you through adding an existing e-mail account to Outlook.

Web-based E-mail

Many e-mail clients run as a specific program on a local computer,
such as Microsoft Qutlook, and access to e-mail is from that client alone.
This is popular with many businesses and organizations because of the
control and security it offers. More flexible access to e-mail can be had
with a web-based e-mail client. Examples of web-based e-mail are Gmail,
Yahoo! Mail, and Outlook.com (formerly Hotmail).

The benefit of this type of e-mail client is that a user has access to it
anywhere there is an Internet connection. A web browser is used to access
the e-mail client via the Internet. Navigate to the log-in web page for the
client, and enter your username and password. Once logged in, you will
have access to the messages as well as the features of the client.

21 Living Online
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Web-based e-mail clients tend to be used for personal accounts.
Many are free, but the user may be exposed to advertising on the website
Additionally, since these domains are widely known, they are often the .
targets of spam. Another downside to web-based e-mail clients is that
these sites experience frequent attacks by cyber criminals.

HANDS-ON EXAMPLE 15.1.1 (conTINUED)

4. Complete the first page of the wizard by entering your name, the e-mail address you wish to
add, and the password for that account, as shown.

Add Account

Auto Account Setup
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Figure 15-2. Microsoft Outlook is the e-mail client for the Microsoft Office suite.

HANDS-ON EXAMPLE 15.1.1
ADDING AN ACCOUNT TO OUTLOOK

1. Launch Microsoft Outlook 2013.
2. Click the File tab in the ribbon to display the backstage view.

right. The Add Account wizard is launched.

) See morssbout SwesSaintSpouin..,

Mcrosoft Outlook is a personal communication tool that can be used to manage a single
e-mail account or multiple accounts. A wizard is used to add an account to Qutlook.

3. Click Info on the left of the backstage view, and then click the Add Account button on the

Goodheart-Willcox Publisher
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Appropriate E-mail Use

Digital citizenship is the standard of appropriate behavior when
using technology to communicate. Good digital citizenship focuses on
using technology in a positive way rather than using it for negative
or illegal purposes. E-mail has grown beyond personal uses. In many
cases, e-mail has taken the place of traditional printed business
correspondence. In addition, many social engagements are set up using
e-mail. It is important to use Standard English to conduct these types
of communication. Complete sentences, correct spelling and proper
grammar are required. For casual e-mail conversations with family and
friends, less importance can be placed on this.

Header

The header contains the e-mail addressers of all who will receive the

e-mail and a subject line. The main recipients of the e-mail are listed in the

To line. Enter the e-mail address of each person who is required to act on

the message in this line.
In addition to the main recipients, copies of the message can be sent

to other people. This is similar to other people in a room who are listening

to your conversation with another person.

Copyright Goodheart-Willcox Co., Inc.

5. Click the Next button. Outlook attempts to automatically configure your account.
6. When Outlook has configured the account, click the Finish button. Outlook displays the e-mail

messages on the e-mail server waiting to be delivered to this account.

Living Online

3.12,41.1

Always strive for proper
spelling and grammar
use, even in casual
messages; it reflects on
you.

Living Cnline
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3.1.2.2

Ablind computer copy
is often used to send a

| targeted mass e-mail,

| such as a product

\ : announcement, so the
e-mail addresses of

all recipients remain
private.
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CC

. .Thet;ZC or Copy line is used for e-mail addresses of people who will
CO eigf e e-mail, .bl-.lt who are not the main recipient. Somebody who is
¢ nlpy H;)r;ranhe-malillls provided the message for informational purposes

: she usually is not required to act
addresses are visible to the recip%ents. R g e

CC stands for carbon co
PY. In the past, i
used to compose letters and ) e g el

BCC

The BCC or Blind Copy line is used to send g private copy to

Eogleﬁo(z{ BCC stands for blind carbon copy or blind computer copy.
~matt addresses in this list are not seen b ' .
. . Y any other recipient.
?en;illin%c an e—mz.ﬂI‘ to a large number of people, the BCC Ijﬁe ?anvlfj = d
tﬁ; TO(IJ- thei-r ;Zmilents. The sender enters only his or her e-mail add;lzgs in
1ne. Lhis keeps all e-mail addresses i i
e-mail address is visible to the recipients. Fordnal Grly G senders

Subject Line

The subject line should clearly and concisely state the topic of the

e-mail. A clear subject line provides information to the recipient and helps

to determi 10T i
ermine the priority for reading the message and where to store it By

[T— e 1 .
using the subject line on the topic of the e-mail, readers can more easil
, ¥

keep track of replies.
The subject line is also im
. portant because it is the info i
Til;sp]layecl by the IMAP protocol, as shown in Figure 15-3 ;11111: zlgr?de !
) : : i 1y
Sereif:ame ?r e-mail addr.ess, the subject line, and the delivery time to ft};‘l
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Body
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, ecaret i : .
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Figure 15-3. The subject line is displayed in the user’s inbox when an e-mail
message is received.

these clients will either receive a plain-text version of the e-mail or the
e-mail will be bounced back to the sender.

When sending a formal e-mail, it should include a salutation, the
message, and a complimentary close and signature. Casual e-mail to
family and friends does not need to be as formal.

Salutation

The salutation is the greeting in the message. The general rule is to use
traditional salutations, but e-mail tends to be more informal than letters.
You may use the salutation “Dear” as in a letter, depending on whether
you are writing a formal or informal e-mail. People often address each
other by their first names in e-mails. Use your judgment based on your
relationship with the recipient. If you address the recipient by first name
in person, it is usually correct to do the same in written communication.

Message

Format the e-mail message the same as a letter or a memo. Use
appropriate spacing, as shown in Figure 15-4. Always follow netiquette
when writing both personal and business e-mails. Netiquette, or Internet
etiquette, is a set of guidelines for appropriate behavior on the Internet,
including e-mail. When you are sending e-mail as a representative of
an organization or business, use Standard English and the spell-check
feature before sending. Remember, your e-mail could be forwarded to
others who might make judgments about what you have written.

Capyright Goodheart-Willcox Co., Inc,
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As with all Microsoft
Office applications,

by default Outlook
automatically displays
spelling and grammar

errors.
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Click to add an
attachment to the
e-mail message
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Figure 15-4. This e-mail is properly formatted. o

Complimentary Close and Signature

E-mail often takes the place of routine phone calls and face-to-
ff_;lce conversations. Writers often forego including a closing and formal
signature in these kinds of messages. However, a courteous thank-you at
the end of the message is usually appropriate.

For an e-mail that is used in place of a formal letter, it is important
to include a complimentary close just as in a printed letter. Include your
full name and contact information at the bottom of the e-mail for the
convenience of the reader. A handwritten signature can be included as a
graphic, but this is not common. Most e-mail programs allow the user to

set up a signature to be automatically inserted, which is discussed later in
this chapter.

Living Cnline
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Replying and Forwarding Messages

If you receive an e-mail message, it may require a response. There are
three basic ways to respond to an e-mail message:

* reply

® reply all

Living Online

3.1.2.1

e forward

Copyright Goodheart-Wilicox Co., inc.
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The reply option sends your comments to the sender. Depending on
the settings of your e-mail client, the original message may or may not be
included. The default is usually to include the original message. The reply
all option sends the return message to everyone who received the original
e-mail, except blind copy recipients. The forward option sends the reply to
a new recipient. A new e-mail address must be entered in the To line.

Stay with the original topic in your reply. If you want to bring up
anew topic, send a new e-mail and note the topic in the subject line.
Creating a new e-mail with a new subject line makes it easier to keep the
information flow understandable. Additionally, it allows both the sender
and recipient of the e-mail to electronically file and organize the e-mail.

Computing Fundamentals

Attachments 5.1.1
Most e-mail clients allow files to be sent along with the text part E;E"iozm

of the e-mail message. Any type of file can be sent. It is common to
share work with others by sending attachments. Reports, spreadsheets,

Key Applications

presentations, databases, or just about any other type of work in digital 6.2.1
form can be shared as an attachment to e-mail. Most e-mail clients-use
the image of a paper clip to indicate the command for attaching a file, as
shown in Figure 15-4.

However, because of the danger posed by malicious attachments, —
some e-mail clients or servers will not accept them. One of the file types };

most often rejected is compressed files, such as a ZIP file. This is because
compressed files can hide executable files within that may bring malware
to the client computer. It may be a good idea to send an e-mail to alert the
recipient you will be sending another e-mail with an attachment.

This danger is real. Any attachments that arrive on e-mail messages
must be carefully handled. In general, do not open an attachment
without a subject line, if you do not know the recipient, or if it is not fully
explained in the body of the message.

Ensure both the e-mail client and the recipient can handle the size and
type of the file. Many e-mail servers have limits on the size of files that can
be received. Limits are placed on attachment size for most mobile e-mail
clients as well. In general, files that are smaller than 1 MB can be accepted
by most e-mail servers. If a file is larger than that, you may need to first
send an e-mail to ask if the person will be able to receive a large file. For

Paperless Society
Even though much written
communication today
is in the form of e-mail,
paper still helps people
communicate. Paper is
still used in business to
take notes, write reports,
and perform other tasks.
IT companies can take
measures to reduce the
consumption of paper
by adopting eco-friendly

very large files, a better option may be to set up an FTP or cloud site that | -F_Jractice_s._ .
can be used to transfer the files. R
Address Book
Living Online
Remembering a variety of e-mail addresses is difficult. To a gl 5.1

accommodate this, most e-mail clients provide an electronic address
book. An address book contains the e-mail addresses of contacts and may
contain other information for each, such as a phone number and notes
about the person, as shown in Figure 15-5. Most e-mail clients will suggest
contacts from the address book as the To line is filled in. This makes it easy
to select a recipient without having to enter the entire e-mail address.

Copyright Goodheart-Willcox Go., Ine.
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Whenever a group of people is sent the same types of messages, a
contact group can be created in the address book. A contact group is a named
collection of e-mail addresses from the address book. One name is applied
to the entire list. When this name is entered in the To line of an e-mail
message, the e-mail will be sent to all contacts within the group. Alternate
names for contact group are distribution list, contact list, and group.
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Figure 15-5. This is the information for an entry in the user's address book.

HANDS-ON EXAMPLE 15.1.2
CREATING A NEW CONTACT GROUP

. Cor}tact groups make it easy to send an e-mail to a large number of addresses at the same
time. It is easy to set up a contact group in Microsoft Office.
1. Launch Microsoft Qutlook 2013.
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ltems>Contact Group in the drop-down menu. The Contact Group dialog box is displayed,

as shown.
[tems
Click to add members
FE ™ I TSI R Students for IT Clags - Coantaes Graup
CONTACTGROLP | INSERT  FORMAFTET  REVIEW
= g} E a8t - @ e e | g 'S
B X & = 8 & B m :
Save B4 Delete Members: Motes Add Remove Update | Cotegarize Follow Privatz | Towr
Name of Clase Group Grau; Wiermbers - bember o = up- ;
p i P
the gr()up \\_ . Actlars . Show  Mempers o Tag: . . fomm
miﬁf&;ﬁs for IT Class o
{1 wame - ) 1 E-mafl
: 2] Harvey lackson (hisckson@sd205502] ; _ . higtkson@sdd05.0z
Members in /I Eshamta Rosewond prosewood@sca05.aa) sTosewond@s0405.277
the group

® 3. Click the Add Members button in the Members group on the Contact Group tab of the
Oy ribbon in the dialog box, and click New E-mail Contact in the drop-down menu. The Add

Add New Member dialog box is displayed.
Members 4 Click in the Display name: text box, and enter your first name.
5. Click in the E-mail address: text box, and enter your e-mail address.
6. Click the OK button to create the contact and add it to the contact group being created.
7. Applying what you have learned, add two more contacts using the information for two of
your friends.
= 8. Click in the Name text box at the top of the Contact Group dialog box, and enter Me and My
E:JJ Friends. This is the name of the contact group. Notice the title bar of the dialog box reflects

Save & the name once the [Enter] key is pressed.

in the dialog box.

new e-mail message is opened.

Tou | tacts and contact groups saved in the address book.

Close 9. Click the Save & Close button in the Actions group on the Contact Group tab of the ribbon
7| 10. Click the New ltem button (new e-mail) in the New group on the Home tab of the ribbon. A

11. Click the To... button. The Select Names dialog box is displayed, which lists all of the con-

To..  12. Select the Me and My Friends group in the list, and click the To-> button at the bottom of the

dialog box.

13. Click the OK button. Notice the name of the contact group appears in the To text box in the

message. When the message is sent, it will go to all contacts in this contact group.

Managing E-mail Communication

Most e-mail clients have several features to help manage
communication. Automated features can be set to send a reply or forward
a message. Personal folders can be created to organize messages. Filters
can be set to manage unwanted e-mail. E-mail messages can be deleted or

archived.

Copyright Goodheart-Willcox Co., Inc.
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2. Click the New ltems button in the New group on the Home tab of the ribbon, and click More
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Automated Features For example, you may wish to forward the e-mail to an account that can
In today’s world of instantaneous news feeds, messaging, and social be accessed from your smartphone or other mobile device.

media communmication, often e-mail is expected to function like a text or .

instant message. Sometimes, it can function like that, with a reply being Signatures

received seconds after the original message was sent. However, in most A signature, or signature block, is content, usually text, that is

cases, it will take minutes, hours, or even days for somebody to reply to automatically entered each time you start a new e-mail message. In the

your e-mail. When you find yourself in a situation where you will not signature block, include your name, job title, department, and contact

be able to reply to a message in a timely manner, there are automated information. It is customary to include the e-mail address in the signature,

features that can help. since many e-mail clients display the sender’s full name instead of the

e-mail address. :
Auto Respond It is also common to include graphics and hyperlinks in the

signature. For example, many businesses and organizations will include
a logo. Icons are also often included for social media, such as Twitter and
Facebook. Each graphic is typically hyperlinked to the corresponding web

The auto-respond option sends a set reply to every e-mail message
received. A message such as:

Thank you for your e-mail. We will respond as soon as M
possible. destination.
allows the sender to know you received his or her e-mai i i
-mail. This provides
feedback even if you cannot send a direct reply. If the sender does not RErCNa) Folaen: / Liyhag nlloe
hear from you for a few hours or even a few days, he or she can be Received messages appear in the Inbox folder. Sent messages are 3.1.34
assured you received the e-mail. This does not, however, let him or her automatically placed in the Outbox until sent by the e-mail client. Once
know whether or not you actually opened the e-mail. : sent, they are automatically moved to the Sent or Sent ltems folder. There
are typically other default folders as well, depending on the e-mail client.
| | Micrasoft Outiook Read Receipt Subfolders can be created in the Inbox folder. These can be used to
\ ‘ i | | EricAugspurger requested a read receipt be sent Th ; sort and hold your old mail messages. Create folders by project, sender,
i) t whenmessage ‘Please respond by Fricay’ Is read, ere are times where you, as the sender . i 7 4
1 ‘ | Do you want to 5and = recernt? need to know if somebod 4 th e or whatever scheme you desire, as shown in Figure 15-7. The fewer files
it [ oon't ask me about sending reczipts again Click to .. taly ma the e-mail. If the in your inbOX, the faster your e-mail client will load.
[V i ‘ ‘ o i recipient has set up an auto-respond message,
i" i es o = | then you will know if he or she received it, but Junk Mail |
- not if the message was opened. A read it i Living Online
Goodheart-Willcox Publisher P - A read receipt 1s a : ; . : )
; i Figure 15-6. The recipient usually can decline to send - -1 1essage sent when the original message UHSOIICItEd e—majl‘rr'tessages are knowr} i o i~ e-m.‘nl. Junk 3.1.26,3.13.1
. a read receipt, depending on the e-mail client. has been opened. Not all e-mail clients su pport e-mails are oft(?n unsoll'C}ted marketing ngtu:es. Many ]unk_e-maﬂs are :Ehe
i || | rerfld‘ receipts. Also, the person receiving the result of checking c:ir fa;hng to uncheck a sgl:;scnbe to r.ricizle upcfates
)| l ‘ original message usually has the option to decline check box on an order form. Once you provide:ane-mail address fo one
| sending the read receipt, as shown in Figure 15-6. Therefore, this is not a company, it may I:Te sold FO other companies. The company you gave your
| foolproof method of knowing if somebody has read a message. e-mail address to in the first place may also send junk e-mails.
! | 5 Read receipts can Most e-mail servers have junk e-mail filters. There are several e-mail
| | be distracting to the Out of Office blacklists the IT industry uses to help protect clients from junk e-mail. If a
| oo 2 3 ; server IP address appears on one of these blacklists, most e-mail servers
Iy ‘ i recipient, and some L= gufbuiniiies messages an auto-response message generated will block an e—melljif from that address. Some e-mail servers are stronger 1
! | people consider them once for each user who sends e-mail to the address. When you will be ) . y kl h h ' 8 In some e-mail clients,
e | rude. Use them onl unavailable for a long period of time, use the out-of-offi ineaforinig e iapktists thunare ofthes SCrvers. i manually moving a
l Y : ’ of-ottice feature to send Most e-mail clients also have some form of junk e-mail filter. If an
when there is a critical a message stating when you will return. This i il ] ' message to the Junk
' I " e awourbesy. It allaws the e-mail is detected as junk, it is automatically moved to the Junk or Junk ;
‘ need to do so. sender to know you are unavailable instead of not responding to his or ; Jun s . ! _ folder will set a rule so
. v | ‘ her message., E-mail folder. Unfortunately, sometimes e-mails tk}ail: are not ]1'mk can be similar e-mail messages
| flagged and moved to the Junk folder. Therefore, it is a good idea to check are automatically
. | | Auto Forwardin g the Junk folder every once in a while to see if any of the messages are not flagged as junk.
L The auto-f dine £ . really junk. Adding the address of the misdirected e-mail message to your
i | . Jorwarcing feature automatically sends a copy of any address book may prevent this mishap in the future.
IR received e-mail to a different e-mail account. This is useful for a POP
| 3 account when you will be away from the client computer for some time.
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3.1.25,3.13.1

= Living Cniine

< 4.1.4

The term spam originated
as a reference to a Monty
Python skit about the
canned-meat product
Spam. During the

skit, the name Spam is
repeated over 100 times.

Living Online

3.1.3.2
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Figure 15-7. Folders can be created to arrange messages by topic, such as by
class or activity.

Spam
Spam is a type of junk mail. Spam is one unwanted e-mail message
sent to a large number of users or multiple identical unwanted messages

sent to a single e-mail address. Spamming is unethical. It is usually part
of a scam or done to overload an e-mail server.

Cleaning Up E-mail Folders

When messages are kept in an e-mail Inbox folder, Sent folder, or
other subfolders, disk space is consumed. Also, these messages are loaded
each time an e-mail client starts up. This takes extra time. In order to free
space and speed up loading, messages may be archived or deleted.

Archiving E-mail Messages

If an e-mail message is not needed at the moment, but important
enough to keep, it can be archived. Archiving consists of storing e-mail
messages in a place where they will not load every time the e-mail client
is launched, but can be accessed if needed. Many e-mail clients archive
e-mail messages in a compressed file that is saved on the hard drive.
This file can be opened to access the messages it contains, as shown in
Figure 15-8. Once the archive file is closed, the messages are no longer
available until the file is again opened.

Some e-mail clients will prompt you to archive old messages.
Messages can also be manually archived. This is useful to store all e-mail
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Figure 15-8. Archived messages are not loaded each time the client is launched,
but can be accessed if needed.

messages related to a project with the other project files. If personal
folders are created by project, it is a simple step to archive the project
e-mails.

Deleting E-mail Messages

To delete an e-mail, simply highlight it and press the [Delete] key or
click the Delete button in the e-mail client. However, this does not remove
the e-mail. Most e-mail clients move deleted e-mails to the Deleted folder.
The messages remain there until the folder is emptied. Some e-mail
clients are set up to automatically empty the Deleted folder when the
client is closed. In other cases, the folder must be manually emptied.

What you say in an e-mail likely will always be accessible by
somebody. Even when the Deleted folder is emptied, the e-mail is not
permanently removed. E-mail servers generally do not delete e-mail
messages for legal reasons. E-mail providers may be subpoenaed by law-
enforcement agents when investigating crimes.
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15.1 LSECTION REVIEW

3

g CHECK YOUR UNDERSTANDING

1. What stores and delivers e-mail messages”?

2. Which protocol is used to transfer e-mail from
one system to another?

3. What is the simplest credential for an e-mail
account?

4. Why are compressed files, such as ZIP files, sent

as attachments often rejected by e-mail clients or
servers?

5. How does a junk e-mail filter work?

IC3 CERTIFICATION PRACTICE

The following question is a sample of the types of
questions presented on the IC3 exam.

1. Interactive question.

Demonstrate how to set up an out-of-office reply
using a Microsoft Exchange server.

#® BUILD YOUR VOCABULARY

As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career, Write a

definition for each of the following terms and add it to
your IT glossary.

address book junk e-mail

archiving message header
auto-respond option netiquette

contact group out-of-office message
credential post office protocol (POP)
digital citizenship simple mail transfer
e-mail client protocol (SMTP)

e-mail server spam

Internet message access  username
protocol (IMAP)

Copyiight Goodheart-Willcox Co., Inc.

REAL-TIME
COMMUNICATION

One of the most noteworthy
innovations in the recent past is the ..
development of mobile technologies. =_s sential
Beginning over 70 years ago with the '
invention of cellular technology, the -
evolution of the mobile industry has % ok social\\
been fascinating. The first handheld
mobile phone weighed 2.5 pounds and  way in which news is
had a range of only five miles. Now reported?
they are pocket-sized and virtual full-
fledged computers. In addition to phones, laptops and
tablets provide computing on the go.

There are many technologies that support real-
time communication. Technologies such as SMS
and IM support text messages. MMS supports.
multimedia messages, while VolP supports voice.
Videoconferencing and streaming video support
transfer of video. This section explores the technologies
that form the foundation of mobile communication.

SECTION

15.2

media changed the '

LEARNING.

GOALS

After completing this

section, you will be able to:

¢ Discuss telephone
technologies.

e Explain various
communication tools.

Copyiight Goodheart-Witicox Co., Ins.

TERMS

blog

carrier

cell

cellular technology
flaming

forum

instant messaging (IM)

multimedia messaging
service (MMS)

g
really simple syndication
(RSS)

short messaging service
(SMS)

streaming
videoconferencing

Voice over Internet
Protocol (VoIP)

605




